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Introduction

This guide provides a solution for syncing the Sony Ericsson P900 to iSync. This has been 

tested successfully using the following configuration:

-Apple PowerBooks (1.3 and 1.5 ghz) running Mac OS X Panther: 10.3.3 and 

10.3.4 with built-in Bluetooth (it has not been tested using a Bluetooth 

adapter)

-Apple iSync 1.4

-Apple iCal 1.5.2

-Apple Bluetooth 1.5

-Sony Ericsson P900 running R5A07 firmware

This guide has not been tested with other bluetooth devices

This solution was provided to me by Brandon Jenkins.  It involves editing four files on the 

Mac to enable the P900 to communicate with iSync.

I have compiled this guide to help other users in the same situation where the P900 and iSync 

won’t communicate.

It does not provide a solution to sending SMS messages from Apple Address Book through 

the P900 phone.  This issue appears to be due to a flaw in the P900 and would need to be 

corrected by Sony Ericsson.

Although these steps fixed the synchronisation issue for me, I would advise caution when 

using this guide.  Always make a backup of your data first.  The steps in this guide are used 

at your own risk.

Best of luck,   Simon Spence



Before you begin:

Please download the p900.zip file which contains 

the 4 files necessary in this guide:

http://homepage.mac.com/sspence/p900.zip

Once downloaded, unstuff the files to your desktop.  You will find a folder called “p900” 

which contains four files:

• ABDeviceCommandSets.plist

• SupportedDevicesInfo

• SymbianConduit_phones.plist

• SymbianConduitDefaults.plist



1/ Clear Bluetooth Preferences and Pairings:

Remove existing Bluetooth pairings 

-Open System Preferences

-Click on Bluetooth and click on Devices

-Select your P900 pairing and write 

down the device address:

it looks something like “00-0e-07-ca-7b-

5b”

You will need this address later

-Now delete all Bluetooth pairings in 

System Preferences by clicking on 

“Delete Pairing” and then “Delete”

-Quit System Preferences

Remove hidden Bluetooth preferences on the Mac

-Open Terminal (you will find this in the Utilities folder in 

the Application folder on your hard drive)

-Type the following into Terminal and then press return:

sudo rm /var/root/Library/Preferences/blued.plist

Enter your admin password when prompted, and then press the Return key

-Now Quit Terminal and restart your Mac



In Steps 2 - 5, four separate files need to be modified on your Mac:

2/ SymbianCondutsDefaults.plist

Go to the following Location:

/Library/Application Support/SyncService/501/SymbianConduitDefaults.plist

[note that the above location begins with the computer’s Library folder at the the top level of 

your hard drive, and not in the user’s home directory]

-If there is already a SymbianConduitDefaults.plist file in this location, move 

it to the trash

-Move the downloaded SymbianConduitDefaults.plist to the “501” folder

-Open the file in TextEdit and change one item- you will see an 

 address:

<string>00-0e-07-ca-7b-5b</string>

You need to replace this address with the address you wrote down at the start of this guide; 

the P900 address found in System Preferences.  This is the unique address for your phone.

- Once you have typed in the correct address for your P900 phone, save and 

 close the file.

-Quit TextEdit



3/ ABDeviceCommandSets.plist

-Open the downloaded file called “ABDeviceCommandSets.plist” in TextEdit

-Copy all its contents by choosing Select All and then Copy from the Edit

 menu.

-Now close the window and Quit TextEdit

Then,

-Open Terminal

-Type the following and then press the Return key:

open "/Applications/Address 

Book.app/Contents/Resources/Telephony.bundle/Contents/Resources/ABDeviceComm

andSets.plist"

[note that the text above is all one line and there is only one space between “Address” and 

“Book.app”]

The existing file called “ABDeviceCommandSets.plist” on your Mac will open in TextEdit.  

-Now choose Select All from the Edit menu and then press delete, and then 

paste in the contents of the downloaded file by choosing Paste from the Edit 

menu.

-Now Choose Save from the File menu and then close the File.

-Quit TextEdit



4/ SupportedDevicesInfo

- Open Terminal and type in the following and press the Return key:

sudo pico 

/System/Library/SyncServices/SymbianConduit.bundle/Contents/Resources/Supporte

dDevicesInfo

[note that the text above is all one line and there is only one space between “pico” and 

“/System...”]

- If prompted for a password, enter it and press the Return key

-The file now opens in “Pico”, a file editor.   Use the down arrow key to 

move down the file until you come to this line:

<key>P900</key>

cont.->



Edit the following section by using the arrow keys to move to where you need to make 

changes.  Delete the incorrect text and replace it with the correct version.  I have highlighted 

the most likely changes in red.  Edit the section so it looks exactly like this:

<key>P900</key>

<dict>

<key>ATI3Response</key>

<string>BVP900</string>

<key>AgendaDatabasePath</key>

<string>c:\documents\agenda\agenda</string>

<key>AgendaMappingsPath</key>

<string>P800AgendaMappings</string>

<key>ClassId</key>

<string>5251596</string>

<key>MappingsPath</key>

<string>P900mappings</string>

<key>iSyncIniPath</key>

<string>c:\documents\iSync.ini</string>

</dict>

Once you have finished editing the text, do the following:

-press ctrl+o

[this is the letter “O” and not the number “0”]

-then press the Enter key once to confirm changes

-then press ctrl+x to exit Pico

-Now Quit Terminal



5/ SymbianConduitPhones.plist

Go to the following location

/System/Library/SyncServices/

-Find the file called 

SymbianConduit.bundle

-Control-click on this file and 

choose “Show Package Contents”

-The file will open and you will 

see a folder called “Contents”- 

open it

-Inside, open the “Resources” folder

-In Resources, find the file called  “SymbianConduitPhones.plist” and move it 

to the Trash.  You will be asked for your admin password to do this.

  

-Enter the password and click OK

-Now move the downloaded file called  “SymbianConduitPhones.plist” to 

the Resources folder to replace the removed file.  You will receive the 

following warning:

-Choose “Authenticate” and then enter your admin password and click OK

-Now close all of the open windows



6/ Pairing and iSync

On the P900:

-Turn on or restart your P900

-Go to Control Panels and click on the Connections tab

-Choose Bluetooth

-Make sure that there are no devices listed in the “Devices” tab of Bluetooth

-In the “Settings” tab, turn Bluetooth on and tick “Visible to other devices” 

-Click “Done” and return to the main P900 menu.

On your Mac:

-Open the Bluetooth Setup Assistant; you will find it in the Utilities folder in 

the Applications folder on your hard drive

SCREEN 1- Introduction: press continue

SCREEN 2- Device type: choose mobile phone from the list of devices 

and click “Continue”

SCREEN 3: click on your discovered P900 (normally called P900) and click 

on “Continue”

SCREEN 4: you will be given a code which you should now enter on your 

P900 and click on “Done” on the phone

A message on the P900 will say that your Mac is trying to connect: click on 

“Accept” on the P900 to allow the connection

SCREEN 5: you will be asked to choose the services for your paired 

phone: 

Choose “Use with Address Book”, “Access the internet...” and “Dial a 

specific access number...”, and then click “Continue.”  

You can’t choose iSync in this Setup Assistant.  

Don’t worry; this is a flaw but isn’t necessary for this guide to work.

[I have not included instructions on how to setup dialling through the P900 

to access the internet.  This can be done later in the Network section of 

System Preferences.  For now choose the “Dial a separate access 

number...”]

SCREEN 6: Just click “Continue” to bypass the internet setup for now.

SCREEN 7: Now the phone is setup- click on “Quit”



iSync:

-Now open Address Book

-The P900 may ask if the Mac can connect: choose “Accept” on the P900

- The Bluetooth button should indicate that the P900 is connected (appears 

in blue)

-If the Address Book doesn’t automatically connect to the P900, click on 

the Bluetooth button in Address Book to activate the link between the P900

and the Mac.

-Once the Address Book and P900 are linked, open iSync

-The P900 should be present in the main iSync window

Bluetooth button



- I would now recommend the following:

If all your contacts and your calendars are in Apple Address Book and iCal, 

choose “Reset all devices” from the File menu in iSync.

WARNING: this will delete all contact & calendar information on the P900 

and on .Mac (if you have .Mac sync turned on in iSync)  and it will be 

replaced by the information in your Apple Address Book and in iCal

The reason I recommend this is that my P900 would not sync correctly until I 

ran this reset.  Afterwards, a normal sync worked correctly.

-After Reset All, your Address Book and iCal information should appear in 

the P900 contacts and calendar applications.



7/ iSync errors

Error |P900| Could not connect to P900. Please check the pairing with this computer.

Warning Can't synchronize contacts to P900: device is not available

If you receive this error message, follow these steps:

-turn off the P900

-Quit Address Book and iSync

-Turn on the P900

-Open Address Book and ensure that the Bluetooth button is blue- if not 

click on the Bluetooth button and choose “Accept” on the P900 when 

requested

-Now open iSync and click on “Sync Now”

If these steps still result in the same error:

-turn off the P900

-Quit Address Book and iSync, and restart your Mac

-Turn on the P900

-Open Address Book and ensure that the Bluetooth button is blue- if not 

click on the Bluetooth button and choose “Accept” on the P900 when 

requested

-Now Open iSync and click on “Sync Now”



If these steps still result in the same error:

-turn off the P900

-Quit Address Book and iSync and restart your Mac

-Turn on the P900

-Open Address Book and ensure that the Bluetooth button is blue- if not 

click on the Bluetooth button and choose “Accept on the P900 when 

requested

-Now Open iSync and choose Reset All Devices from the File menu

WARNING:  this will delete all contact & calendar information on the 

P900 and on .Mac (if you have .Mac sync turned on in iSync) and it will be 

replaced by the information in your Apple Address Book and in iCal



7/ No “501” folder and “File not found” errors

I am unable to find the “501” folder 

mentioned in step 2

In step 2 you are told to replace your file “SymbianConduitDefaults.plist” by the 

downloaded version in the location below:

/Library/Application Support/SyncService/501/SymbianConduitDefaults.plist

However, some users may not have a folder called “501”.  Instead they have folders called 

“502” and/or “503” etc.  This seems to be caused by more than one account on your Mac, 

with “502” containing information for the first user, “503” for the second user etc.

If you find this on your Mac, place the downloaded “SymbianConduitDefaults.plist” file in 

each of these folders.  If, for example, you find that you have access to “502” but not “503” it 

may be because one of the users’ folders is locked and you don’t have correct privileges.  

Therefore place the “SymbianConduitDefaults.plist” file in the folder you have access to and 

this will enable the p900 to work with the current user.  If you place the file in all available 

“5XX” folders, each of these users will see a P900 icon in their iSync window.  

Please also remember to edit the bluetooth address using TextEdit, as outlined in step 2.



Terminal reports and error during step 2 and says the file could not be found

Recheck that you typed the correct command into Terminal.  Quit Terminal and try again.

If you still receive errors you can follow these steps.

To manually place the file 

“ABDeviceCommandSets.plist” in 

its correct location:

1/ Find the application “Address 

Book” in the Applications folder

2/ Hold down the ctrl key and click 

once on the Address Book icon

3. A contextual menu appears- choose “Show Package Contents” 

4/ A window will open with a folder called “Contents”- open it

5/ Inside Contents, open the Resources folder

6/ In Resources, find an icon called “telephony.bundle”

7/ Hold down the ctrl key and click once on its icon

8/ A contextual menu appears- choose “Show Package Contents” 

9/ A window will open with a folder called “Contents”- open it

10/ Inside, open the Resources folder

11/ Move the file “ABDeviceCommandSets.plist” to the Trash

12/ Replace it with the downloaded file called “ABDeviceCommandSets.plist”

13/ Now close all windows and proceed to step 3

Simon Spence/2004

Note: Many thanks to Brandon Jenkins for his help in solving this issue


